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Edition Notes - Release June 2017

Trademarks SyncStudio @ is a registered trademark of HandApps Software (HandApps). The
SyncStudio ® logo in its entirety and all other trademarks on this manual pertaining to services,
products, or marketing statements are owned or licensed by HandApps. Any other product
names, logos, brands, company names, and other trademarks featured or referred to within this
document are the property of their respective trademark holders.

Copyright Notice HandApps Software owns the content of this manual in its entirety, including
but not limited to pictures, logos, trademarks, and resources.

© Copyright 2017 HandApps Software. All rights reserved. Electronically published by
HandApps Software in the United States of America.

Manual Usage - HandApps authorizes its customers to download and print this manual for
professional information purposes only. HandApps expressly prohibits the usage, copy,
storage, distribution, modification, or printing of this manual or its content for any other
purpose without its written consent.

Document Printing - For best results, print this document in color, on letter size paper (8.5 x
11 inches), double sided. If using A4 paper (210 x 297 mm), configure your printer to scale the
content accordingly.

Disclaimer - HandApps Software believes that the information contained in this manual is
accurate in all respects. However, HandApps assumes no responsibility for any error or
omissions in this document. HandApps reserves the right to revise this document and to make
changes from time to time in the content hereof without obligation of HandApps to notify any
person or company of such revision or changes. This does not constitute in any way a
commitment by HandApps to make such changes. HandApps may issue a revision of this
manual or a new edition of it to incorporate such changes.

Document Revision This SyncStudio Quick-Start Manual, Rev. 2.7.x, supersedes all previous
versions of this manual. Discard any older versions and replace with this version.
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Installing and configuring SyncStudio

SyncStudio was created to make database synchronization between SQLite, SQL
LocalDB/Express and Microsoft SQL Server fast, easy and affordable. To get started with
SyncStudio please read this entire document FIRST. You should also already have MS SQL Server
(or SQL Express) installed, either in your own development machine or in some other machine
that you can access over your network. If you don’t have MS SQL Server, you can download a
free copy of SQL Server Express here:

MS SQL Server 2016 Express Edition

To install and configure SyncStudio please follow these steps:

1)
2)
3)
4)
5)
6)
7)

Install the SyncStudio in your development machine

Create a sample SQL Server database

Create a test SyncStudio Project and connect to the test database
Configure the project

Deploy the project to your IIS Server

Install the SyncStudio Client in your Android device

Test the synchronization
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Critical Installation Notes and Pre-requirements

PLEASE NOTE:

ONLY THE X86 VERSION OF MICROSOFT SYNC FRAMEWORK CAN BE INSTALLED ON THE
MACHINE RUNNING SYNCSTUDIO. IF YOU INSTALL THE 64-BIT VERSION OF
SYNCFRAMEWORK SYNCSTUDIO WILL NOT FUNCTION AND YOU WILL NOT BE ABLE TO
SYNC YOUR DEVICES/OFF-LINE DATABASE.

In order for SyncStudio to function certain Windows Features/Roles need to be installed and
configured properly. Below are screenshots showing the required settings for Windows Server
2012 or Windows 10.

You must be logged in with an account that has Administrator privileges.

Windows Server 2012 - Features and Roles

=) Add Roles and Features Wizard
Select features

Before You Begin Select one or more features to install on the selected server.

Installation Type Features

Server Selection ~
A .NET Framewaork 3.5 Features

Server Roles

.NET Framewark 3.5 {includes .NET 2.0 and 3.0}

HITP Acation

Web Sarver Rale (II5) ] Non-HTTP Activation
Role Services 4 [H] .NET Framework 4.5 Features (2 of 7 installed)
Confirmation | .NET Framewaork 4.5 (Installed)

ASP.MET 4.5
4[] WCF Services (1 of 5 installed)
|
O Message Queuing (MSMQ) Activation
[[] Mamed Pipe Activation
[] TCP Activation
| TCP Port Sharing (Installed)

p O Background Intelligent Transfer Service (BITS)

[[] BitLocker Drive Encryption
[ BitLocker Metwork Unlock
[ BranchCache

[ Client for MFS

[] Data Center Bridging

[] Direct Play
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Select role services

Before You Begin Select the role services to install for Web Server (115)

Installation Type Role services

Server Selection

| >

4 Web Server
4 Common HTTP Features
Features Default Document
Web Server Role {I1S) Directory Browsing
HTTP Errors =
Confirmation Static Content
[ HTTP Redirection
[[] WebDAV Publishing
4 Health and Diagnostics |
HTTP Logging
[] Customn Logging
[ Logging Tools
[] ODEBC Logging
[] Request Monitor
[] Tracing
4 Performance
Static Content Compression
| Cynamic Content Compressiol
4 Security
Request Filtering

Server Roles

<]

Select role services

Before You Begin Select the role services to install for Web Server (115)

Installation Type Role services

Server Selection

[>

4 Security
Request Filtering
[] Basic Authentication
Web Server Role {IIS) [] Centralized S5L Certificate Support
[] Client Certificate Mapping Authentication

Server Roles

Featuras

Canfirmation [] Digest Authentication
[] 1S Client Certificate Mapping Authentication
[] 1P and Domain Restrictions -
[ URL Authorization
[ Windows Authentication

4 Application Development
MET Extensibility 3.5 =
NET Extensibility 4.5
[ Application Initialization
[] asp

| =

ASP.NET 4.5
I cal
ISAPI Extensions
ISAPI Filters

<]

Page 6 of 36



Select role services

Before You Begin Select the role services to install for Web Server (lIS)

Installation Type Role services
Server Selection
e Kal

Server Rolas ASPNET 3.5
Features ASP.MET 4.5
Web Sarver Role {I15) O cal

; ISAPI Extensions
Confirmation ISAPI Filters

[1 Server Side Includes
[ WebSocket Protocol
4[] FTP Server
[ FTP Service
[ FTP Extensibility
4 Management Tools
lI5 Management Console
4 II5 & Management Compatibility
IIS 6 Metabase Compatibility
IIS & Management Conscle
IS 6 Scripting Tools
115 6 WMI Compatibility
IIS Management Scripts and Tools

| Management Service

<|
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Windows 10 - Features and Roles

Turn Windows features on or off

To turn a feature on, select its check box. To turn a feature off, clear its check box. A filled box means that only part of the feature is turned on.

= [m] © .NET Framework 3.5 (includes .NET 2.0 and 3.0)
Windows Communication Foundation HTTP Activation
[[] Windows Communication Foundation Non-HTTP Activation
= IE .NET Framework 4.6 Advanced Services
ASP.NET 4.6
= [®] | WCF Services

HTTP Activation

[0 Message Queuing (MSMQ) Activation
[J Named Pipe Activation

1 TCP Activation

TCP Port Sharing

[J = Active Directory Lightweight Directory Services
[0 containers
[J Data Center Bridging
1 Device Lockdown
L

Hyper-V
Internet Explorer 11
= [m]  Internet Information Services

[]  FTP Server

= Web Management Toals

= 1IS & Management Compatibility

1S 6 Management Console
11S & Scripting Tools
11S & WMI Compatibility
1S Metabase and IIS 6 configuration compatibility
115 Management Console
IIS Management Scripts and Tools

1IS Management Service

RERIE
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Turn Windows features on or off

To turn a feature on, select its check box. To turn a feature off, clear its check box. A filled box means that only part of the feature is turned on.

= [®] " World Wide Web Services
= [m]  Application Development Features

.NET Extensibility 3.5
.NET Extensibility 4.6
Application Initialization

ASP

ASP.NET 3.5
ASP.NET 4.6

CaGl

ISAPI Extensions
ISAPI Filters
Server-Side Includes
] WebSocket Protocol

DRMOMROOERE

= [m]  Common HTTP Features

Default Document

Directory Browsing

[ HTTPErrors

] HTTP Redirection

[ Static Content

] WebDAV Publishing
[ Health and Diagnostics
[0 Performance Features

=@ Security

Centralized SSL Certificate Support
Client Certificate Mapping Authentication

11S Client Certificate Mapping Authentication

1 Basic Authentication
|

O

[]' Digest Authentication
O

1 1P Security

Request Filtering

] URL Authorization
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User Account Control

We recommend you turn off user account control in your development/testing machine. THIS IS

NOT REQUIRED but it makes things go more smoothly.

(|

75 Do you want to allow the following program to install
&/ software on this computer?

Program name:  Microsoft Sync Framework
Verified publisher: Microsoft Corporation
File origin: Metwork drive

e

(%) Show details Yes No

Change when these notifications appear

Choose when to be natified about changes to your computer

User Account Cantrol helps harmful prog
il me more ahout User Account Control settinad

making changes to your computer.

Always notify

Notify me only when apps try to make changes to my
computer (default)

#  Den't notify me when I make changes to Windows
- settings

© Recommended if you use familiar apps and visit
familiar websites,

Never notify

Hok Cancel

7= .|

[

First, launch Control Panel and go to System and Security > Administrative Tools > Local
Security Policy. On the left side of the Local Security Policy windows, find “Security Options”
under “Local Policies”.

The below screen shots show before and after in Windows 8.1

R

g —mm —m

1) User Account Control: Admin Approval Mode for the Built-i...
1) User Account Centrol: Allow UlAccess applications to prom...
1) User Account Control: Behavior of the elevation prompt for ...
1) User Account Control: Behavior of the elevation prompt for ...
[ User Account Control: Detect application installations and p...
1) User Account Central: Only elevate executables that are sign...
1) User Account Control: Only elevate UlAccess applications th..
1) User Account Centrol: Run all administrators in Admin Appr..
1) User Account Centrol: Switch to the secure desktop when pr..
1) User Account Centrol: Virtualize file and registry write failure...

Disabled

Disabled

Elevate without prompti...
Prompt for credentials
Enabled

Disabled

Enabled

Enabled

Disabled

Enabled

-

Below is after changes

P L e

L T

Admin Approval Mode for the Built-i...

Allow UlAccess applications to prom...

121o) User &ccount Control:
lvio) User Account Control:
loio) User Account Control:
ltio) User Account Control:
ltio) User Account Control:
121o) User Account Control:
1) User &ccount Control:
1) User &ccount Control:
1o1o) User &ccount Control:
121o) User &ccount Control:

Behavior of the elevation prompt for ...
Behavior of the elevation prompt for ..
Detect application installations and p...
Only elevate executables that are sign...
Only elevate UlAccess applications th..,
Run all administrators in Admin Appr..
Switch to the secure desktop when pr..
Virtualize file and registry write failure...

Disabled

Disabled

Elevate without prompti...
Prompt for credentials
Disabled

Disabled

Disabled

Disabled

Dizabled

Dizabled
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Crystal Reports

The SyncStudio Sync Management Console requires Crystal Reports Runtime. You can
Download the needed installation package at the following link (CRRuntime_32bit_13_0_7.msi).

Visual Studio

One of the most unique and valuable features of SyncStudio is that it can automatically generate
and compile your unique sync web services DLL. But, in order to do this the computer running
SyncStudio needs to have one of the following versions of Visual Studio.

Visual Studio Express for Web 2012
Visual Studio 2010 Integrated Shell
Visual Studio 2010, 2012, 2013, 2015

Microsoft SQL

SyncStudio supports all versions of Microsoft SQL Server from 2010 through to 2016 and from
Express to Enterprise.

SQL Server Security

Add login NT AUTHORITY\NETWORK SERVICE in SQL security and make it a db owner of the SQL
database you will be synchronizing via SyncStudio.

Windows Firewall

In order for SyncStudio to work it needs to be able to connect from the device or computer
running the client application to the computer running SQL Server. The communication is via
HTTP and TCPIP and therefore proper connectivity and routing must exist.

For testing purposes, you should either turn off your Windows or computer firewall OR
configure the appropriate pass thru settings as needed.

The default HTTP ports for a Windows machine is port 80 and for HTTPS it’s port 441. You can
use whatever port you wish and you can have the connecting device connect to a specific
external port and then setup port forwarding to connect to your SyncStudio machine.

The setup of your ports, port forwarding, routing and firewall need to be done properly or sync
will not succeed.
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Support Sync Client Platforms

SyncStudio enables data synchronization between Microsoft SQL Server and applications using
the platform appropriate SyncStudio Universal Sync Client class library. Currently available class
libraries are as follow.

JAVA Android Apps

Basic4Android Apps

Windows Apps using SQLite

Windows Apps using Microsoft LocalDB, SQLExpress, SQL Standard+
Windows Apps using Microsoft SQL Compact 4

Universal Windows Platform Apps using SQLite

Universal Windows Platform App using Microsoft LocalDB, SQLExpress, SQL Standard+
Windows CE or Windows Mobile Apps using SQL Compact 3.5
Windows CE or Windows Mobile Apps using SQLite

Xamarin for Android

Xamarin for iOS

Soon to be available

iOS Apps using SQLite (iPhone, iPad) - Native

Linux

Mac OS
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Installation

SyncStudio comes with a simple .msi installer. Just follow the steps below to install the
SyncStudio to your development machine.

P4 SyncStudio - InstallShield Wizard =]

Welcome to the InstallShield Wizard for
SyncStudio

 The InstallShield(R) Wizard will install SyncStudio on your
computer, To continue, dick Mext.

WARNING: This program is protected by copyright law and
international treaties.

| < Back |[ Next > ] [ Cancel

ﬂ SyncStudio - InstallShield Wizard X

License Agreement

Please read the following license agreement carefully.

END-USER LICENSE AGREEMENT FOR HANDAPPS SOFTWARE ~

This End User License Agreement (“EULA”) is a legal agreement between you (either an individual
person or a single legal entity) and the maker, HandApps Software, a Florida corporation located at 12932
SW 133 Ct., Miami, FL 33186 {"HASW"), of the HandApps SyncStudio software that accompanies this EULA
[collectively, or separately, the “Software”). The Software includes computer software, and may include
associated media, printed materials, “online” or electronic documentation, and Internet-based services. The
terms of this EULA shall also apply to any applicable updates, supplements, add-ons or Internet-based
Services for the Software unless other termis accompany those items. This EULA is valid and grants the end-
user license rights ONLY if the Software was obtained directly from HandApps Software or a HandApps v

S

()1 accept the terms in the license agreement

(@)1 do not accept the terms in the license agreement

InstallShield
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ﬂ Sync5tudio - InstallShield Wizard

Customer Information

Please enter your information,

User Name:

Organization:

InstallShield

[ <Back | next= || cancel

ﬂ SyncStudio - InstallShield Wizard

Ready to Install the Program

The wizard is ready to begin installation.

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

InstallShield

[ <Back |[ ®imstal | [ cancel
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Preparing to Install...

SyncStudio Setup is preparing the Installshield Wizard,
which will guide you through the program setup process.

Please wait.

Decompressing: SyncStudio.msi

-

Cancel

'ﬁ‘ SyncStudio - InstallShield Wizard
- InstallShield Wizard Completed

The InstallShield Wizard has successfully installed SyncStudio.
Click Finish to exit the wizard.

< Back J[ Finish ] L Cancel J
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The SyncStudio Sample Database

We strongly recommend that you first test SyncStudio using the sample database we provide.
This will give you a good indication of what the product can do and how it works.

WARNING: PLEASE DO NOT ATTEMPT TO USE AN SQL DATABASE THAT HAS PREVIOUSLY BEEN
PROVISIONED OR USED WITH STANDARD MICROSOFT SYNC FRAMEWORK. ONLY USE DATABASES
WITH SYNCSTUDIO THAT ARE CLEAR OF THIRD PARTY SYNC RELATED OBJECTS OR ARE NEW
AND HAVE NOT ALREADY BEEN ALTERED BY OTHER SYNCHRONIZATION TOOLS. IT IS LIKELY
THAT SYNCSTUDIO PROVISIONING WILL FAIL IF ATTEMPTED WITH DB ALREADY PROVISIONED BY
SOME OTHER TOOL.

For this guide, we will be using a small SQL Server (or SQL Server Express) database with only
three tables: CUSTOMERS, PRODUCTS and SALES. The database will be called
SYNCSTUDIO_SAMPLE. To create the sample database:

1) Open the Microsoft SQL Server Management Studio and connect to the MS SQL server of
your choice.

2) On the toolbar click on the “Open File” icon.

3) Browse to the folder “c:\program files (x86)\SyncStudio\Sample DB”. There you will find
a file called “SYNCSTUDIO_SAMPLE.sql”. This is an SQL script file that has everything
needed to create the sample database and also to populate the tables with thousands of
records worth of sample data. Choose this file and click OPEN.

4) MAKE SURE that the selected database in the upper left corner of the toolbar is “Master”.
Also MAKE SURE that you do not already have a database called “SYNCSTUDIO_SAMPLE”.
If you do you must first drop or rename that database or running this script will result in
an error.

5) On the toolbar click on the “Execute” button. It may run for a while so please be patient.

6) When done you will have a new database ready to test with SyncStudio.

7) On the left in “Object Exporter” click on “Databases” and then hit F5 to refresh. You
should now see a database called “SYNCSTUDIO_SAMPLE” appear.
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Create and Configure your SyncStudio Project

Now that you have all three tables created open the SyncStudio program and click on File >
New Project and enter SYNCSTUDIO_SAMPLE for the project name, as shown in the following
screenshots:

SyncStudio - X

File Help
b =

e ” SyncStudio Ver.3.0.2.0

c

L SynNncStrudio

by HeNdApPppPpS

Mo SyncStudio Project Loaded. Please open an existing SyncStudic Project or create a new one.

New SyncStudio Project x

Project Name

Valid Characters: a-z,A-Z, 0-9 Dash ( - ) and Underscore ( _ ) No spaces
are allowed in project names

Gance

At this point you need to connect to the database so that SyncStudio can fetch the database
schema. Please enter the Server Name (this is the same as the top node in the SQL Server
Management Studio), enter SYNCSTUDIO_SAMPLE for the database name and click on the
Connect button, as seen in the following screen. Here we assume that you are connecting to the
database using Windows Authentication. If that is not the case then you can use the
Authentication Pulldown to select SQL Authentication and then enter the SQL Server User Id and
Password of an account that has access to the SYNCSTUDIO_SAMPLE database.
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SyncStudio [SYNC_SAMPLE]

Sync Server Deployment
& User Maintenance

Reporis

- X
File Help
. |
_@ Home
Server Name ha Find Servers
_ﬂ:!_.'Connecl\on Setlings
DB Name SYNCSTUDIO_SAMPLE
Database Articles
— = Authentication ® Windows (O sQL Authentication
1 Database Provisioning
User Login
o Code Generation
Password

You should be connected to the database and SyncStudio will have retrieved the database

schema from the SQL Server.

SyncStudio

Your SyncStudio Client Access License (CAL) needs to be generated or
validated by our licensing server. Please make sure your computer has
internet connectivity and that your antivirus or firewall is not blocking
access to our servers. No personal information of any kind is collected or
sent during this process. Do you want to continue?

Yes No

Unregistered Evaluation

This project is connected to an SQL database that does not contain a valid
SyncStudio license. If you have already received/purchased a license file
please LOAD it into this SQL database using the licensing screen

(accessible via the Help menu).

Without a valid license SyncStudio will be fully functional for 60 days from
first execution and then stop working.

When SyncStudio connects to a database it checks to see if there is a license already installed.
If not the you will receive a message. When first installed SyncStudio will run in a limited
(unregistered) evaluation mode for 3 days. In this mode a license inside the database is not
required but functionality will be limited. A 14 days evaluation license is available at no charge
but it must be requested via our licensing screen. Please see the licensing section of the

SyncStudio User Manual for details.
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Database Articles

Now click on the “Database Articles” tab on the left side of the SyncStudio. You will get a screen
like the one below. All three tables (CUSTOMERS, PRODUCTS and SALES) should be there. We
will now use the SyncStudio to select these three tables for synchronization.

SyncStudio - X
File Help
i ["-ﬂ
‘Objects to Publish for Synchronization Table: CUSTOMERS
@ Home .
Direction Bi-Directional il
# . . CUSTOMERS
¥~ Connection Settings PRODLCTS Conflict Resolution Client Wins i
ol
l@ Database Articles SALES Record Count 2,808

& Database Provisioning Edit Filter Uncheck All

M5~ cusTD

acwe Generation

CUST_NAME

CUST_REGION
Z}Sync Server Deployment CUST_SALES

SS_filtercode
g User Maintenance 55_rowguid

Reports

To select a table for synchronization first click on the table name; you will see that all the fields
are shown, with a checkbox for each field (the default is that all primary key fields will be
checked) and the fields that are part of the primary key indicated with a key icon. For this guide
we will be synchronizing all the fields in all the tables. Click “Check All”

SyncStudio requires you add the field SS_rowguid to any table that you intend to sync with the client application. The following SQL script can be used
to automatically create the ALTER command for each table in your DB.

SELECT 'ALTER TABLE ' + T.name + ' ADD SS_rowguid UNIQUEIDENTIFIER DEFAULT newid() NOT null' FROM sys.tables AS T where t.name not like
'SyncStudio%' and t.name not like '%_Tracking' and t.name not like 'scope%' and t.name not like 'schema_info'

For this guide we want to select all three tables for synchronization, and all fields in all the
tables as well. In your own projects you can select only some tables for synchronization, and
you do not need to select all the fields (but all the fields that make up the primary key have to
be selected).
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Also notice that there is a Add/Edit Filter button. Click the button and form will display with a
pulldown control and an edit box. Open the pulldown and select any field from the table that
you want to use to filter against. Automatically upon selection a default WHERE clause will
appear in the text box area. If you are ok with this standard filter condition just click “OK”.

TableFilter

Filter Main Field:

Filter Clause:

S55_filtercode

*

[side].55_fitercode = &fiter

Cancel

At this point you will have selected all the tables for synchronization. Now we need to provision
the database for synchronization.

££ User Maintenance

Reports

RERIEEA

55_rowguid

SyncStudio — *
File Help
=
~ |-1
Objects to Publish for Synchronization Table: CUSTOMERS
@ Home
Direction Bi-Directional w
# . . CUSTOMERS
¥~ Connection Settings PRODLCTS Conflict Resolution Client Wins v
[==z| ]
l@ Database Articles SALES Record Count 2808
ﬂ_“ Database Provisioning Edit Filter __Uncheck All
M5  cusTD
' Code Generation CUST_NAME
CUST_REGION
‘]t Sync Server Deployment CUST_SALES

S8_filtercode
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Database Provisioning

WARNING: PLEASE DO NOT ATTEMPT TO USE AN SQL DATABASE THAT HAS PREVIOUSLY BEEN
PROVISIONED OR USED WITH STANDARD MICROSOFT SYNC FRAMEWORK. ONLY USE DATABASES
WITH SYNCSTUDIO THAT ARE CLEAR OF THIRD PARTY SYNC RELATED OBJECTS OR ARE NEW
AND HAVE NOT ALREADY BEEN ALTERED BY OTHER SYNCHRONIZATION TOOLS. IT IS LIKELY
THAT SYNCSTUDIO PROVISIONING WILL FAIL IF ATTEMPTED WITH DB ALREADY PROVISIONED BY
SOME OTHER TOOL.

Click on the “Database Provisioning” tab on the left side of the SyncStudio. You will see a screen
like the following.

SyncStudio - *

File Help

& Home ‘ £ Database Provisioning ‘

ﬁ: Connection Settings Status: Database provisioned.

Settings

@ Provision [haazure1,61385.8YNCSTUDIO_SAMPLE] m
[& Database Provisioning l
§Code Generation 60 =

@ Database Articles

E}smc Server Deployment Use Tracking Triggers

g User Maintenance

Active  Project

Jun 82017 3:27PM SYNC_SAMP

" Reports

3 Jun 82017 2:47PM O SYNC_SAMP Jun 8 2017 3:25PM
2 May 23 2017 6:50PM O HA Jun 82017 2:47PM
1 May 82017 11:32PM O SYNC_SAMP May 23 2017 6:50PM
o May 82017 11:26PM O SYNC_SAMP May 8 2017 11:32PM

Prowvisioning prepares your Database Server for Synchronization. If you make changes to the Database Structures
(Schema) or you change the tables to be synchronized you need to de-provision and re-provision.

The Provisioning process creates a number of tables and stored procedures that are used by the
Microsoft Sync Framework to keep track of which records have changed and when, so that the
appropriate records can be sent to the clients.

SyncStudio requires you add the field SS_rowguid to any table that you intend to sync with the client application. The following SQL script can be used
to automatically create the ALTER command for each table in your DB. If you don’t add this field you will not be able to provision the database.

SELECT 'ALTER TABLE ' + T.name + ' ADD SS_rowguid UNIQUEIDENTIFIER DEFAULT newid() NOT null' FROM sys.tables AS T where t.name not like
'SyncStudio%' and t.name not like '%_Tracking' and t.name not like 'scope%' and t.name not like 'schema_info'
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Foreign Keys

If you selected any Database Articles that have Foreign Key’s, then before Provisioning the database you
MUST review and confirm the Sync Order of the tables. Click the “Sync Order” button to open the
control.

SyncStudio - *
File Help
=
Q& Home % Database Provisioning ‘
Synchronization Order *
#: Connection Settings Settings
@ Database Articles SALES ﬁ
PRODUCTS Sync Order
l& Database Provisioning ] CUSTOMERS {}
Process Timeout (seconds)
5'00de Generation B0 =

4 Sync Server Deployment Use Tracking Triggers

{z User Maintenance

Reporis De-Provisioned

Jun 8 2017 3:25PM

Jun 8 2017 2:47PM
May 23 2017 6:50PM

e May 9 2017 11:32PM

Provisioning prepares your Database Server for Synchronization. If you make changes to the Database Structures
(Schema) or you change the tables to be synchronized you need to de-provision and re-provision.

You must carefully arrange the tables in the correct sync order so as to not cause a foreign key violation
during the sync process. If none of your tables have foreign keys then the sync order does not matter.
However, if you have foreign keys then, for example, a new child record cannot be inserted before the
corresponding parent record is inserted first. Be sure you understand the foreign key relationships
between selected tables so you can properly set the sync order. Click on a table then use the arrow keys
to move it up or down into the order you want.

When done click OK.

Use Tracking Triggers (We strongly urge you to enable this option)

In SyncStudio version 3 we introduced the option to automatically create change tracking triggers on the
client side database. In order to maintain backward compatibility, we do not enable this feature by
default. For new SyncStudio projects we strongly recommend enabling this feature. With this feature
on the client database will be fully cable of detecting inserts, edits and deletes without the developer
needing to make any codes changes.
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Process Timeout (seconds)

The provisioning of a database with lots of tables or where tables contain considerable amounts
of data will naturally take longer than when the database is small with little data. In order to
avoid the possibility of an SQL time due to inactivity you have the option of increasing the time
out interval. Sixty seconds is usually good for most cases but if more is needed you can
increase it here before trying to provision the database.

The screen has two options: “Provision Server” and “De-Provision Server”. Click on the
“Provision Server” button. You will see a progress bar appear during the provisioning process.
Note: This database is very small, only three tables and a few fields in each table. For very large
databases with many tables and fields the provisioning process may take some time. Please do
not interrupt or stop the provisioning.

SyncStudio — X
File Help
=
:&Home ‘ % Database Provisioning ‘
7 Connection Settings Status: Database provisioned. Settings
F7 Database Articles = -
[ Provision [haazure1,61395. SYNCSTUDIO_SAMPLE] Sync Order
la Database Provisioning l
[X De-Provision [haazure1,61395.5YNCSTUDIO_SAMPLE] l Process Timeout (seconds)
éCade Generation B0 L
4} Syne Server Deployment Use Tracking Triggers
{{ User Maintenance
Reporis Gen. Provisioned Project De-Prowvisioned
| 4 |uun 82017 327PM - SYNC_SAMP
3 Jun 82017 2:47PM SYNC_SAMP Jun 82017 3:25PM
2 May232017 6:50PM D HA Jun 82017 2:47PM
1 May 92017 11:32PM [0 sYNC_samP May 23 2017 6:50PM
0 May 92017 11:26PM [0 sYNC_samP May 9 2017 11:32PM

Prowvisioning prepares your Database Server for Synchronization. If you make changes to the Database Structures
(Schema) or you change the tables to be synchronized you need to de-provision and re-provision.

If everything goes well you will be given a message telling you that the database is now
provisioned for synchronization. Otherwise, you will get an error message. In order to
synchroniza a database you MUST first provision it.

Server Provisioning Finished X

The Server=ha, Database=SYNCSTUDIO_SAMPLE is
now provisioned for SyncStudio operations.

Page 23 of 36



Code Generation

Now that the database has been provisioned we need to generate the synchronization code. To
do this please click on the “Code Generation” tab on the left side of the SyncStudio. You will see
a screen like the following:

SyncStudio [SYNC_SAMPLE] - X
File Help
|
2 v Sync Server Code Generation
4% Home
%Connecl\on Settings Target NET Framework
- (O NET35
== Database Articles
(O NET40
Eﬂ_“ Database Provisioning @ NET45
l &Code Generation
{4 Sync Server Deployment &Generale Server Code
{E User Maintenance
Reporis

This generates the Server-Side Synchronization Code that needs to be deployed to IS. Please configure the database
and provision first before you generate the code. Note: Code Generation for large databases with many tables will take
several minutes to complete.

Select the version of the .NET Framework that matches the Web Server where the sync project
will be running and then click on the “Generate Server Code” button. You will be given a
message asking you if you want to re-generate the server code, and warning you that any
existing code will be overwritten. In this case this is our first code generation; however, for your
production systems you should probably keep a backup copy of the prior project code in case
you need to restore the system.

Code Generation s

Do you want to regenerate the server code for this project? Any
existing server-side code will be ovewritten.
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Click OK and wait for the code generation to complete. Note: as with provisioning, this is a
small project so that the code generation should be very fast. Large projects with many tables
and fields will take longer. Please be patient. You will see a progress bar while the code
generation is being done, and you will get a message box at the end.

SyncStudio [SYNC_SAMPLE] - X
File Help
.
*H v Sync Server Code Generation
4% Home
_ﬂg.'Connecl\on Settings Target NET Framework
== O NET35
Ff/ Database Articles
(O NET 4.0
" Database Provisioning @ NET 45
l éCode Generation
,‘}SY"C Server Deployment { éGmate Server Code ]
oo Mtorrco |
Reports Code Generation for SYNC_SAMPLE started

This generates the Server-Side Synchronization Code that needs to be deployed to IIS. Please configure the database
and provision first before you generate the code. Note: Code Generation for large databases with many tables will take
several minutes to complete.

Server Code Generation Finished X

Server Code Generation finished for Server=ha
Database=SYNCSTUDIO_SAMPLE.
Errors: 0

At this point your database is provisioned and you have the synchronization code that you need
for the server. Now we need to deploy your synchronization code to IIS. We are assuming that
you are running this sample in a machine that has both SQL Server and IIS installed. In your
production system the database can be hosted in a different machine from the Web Server.

Also, SyncStudio produces compiled code, not source. After you create the server-side code the
build directory in your project will contain the following directories and files:

\bin

\bin\SyncStudioService.dll
\bin\Microsoft.Synchronization.Services.dll
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DataScopeSyncService.svc
DefaultScopeSyncService.svc
Web.config

All the files above are required for deployment. Please do not make manual changes to any of
these files (except for the Web.config database connection, as described below) or your
synchronization project will not work correctly.

The project creates a default Web.config file. The connection string to the database is inside
this Web.config under the tag “SyncStudioCn”.

<add name="SyncStudioCn" connectionString="Server=YOURSERVER\YOURDBNAME;
Database=YOURDBNAME; Integrated Security=SSPI; Connection Timeout=30;"
providerName="System.Data.SqlClient"/>

NOTE: ERRORS DURING CODE GENERATION

If there is an error during code generate please look for a log file in your SyncStudio project
folder called dbSyncStudioSrvcBuildErrorLog.txt.

Open the file and if the error encounted contains something like the following...

Message The specified solution configuration "Debug|MCD" is invalid. Please specify a valid
solution configuration using the Configuration and Platform properties (e.g. MSBuild.exe
Solution.sIn /p:Configuration=Debug /p:Platform="Any CPU") or leave those properties blank to
use the default solution configuration. :

Then do this...

Using regedit.exe, navigate to the registry path
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session Manager\Environment and
selected the key “Platform” if it’s there. If you don’t have the reg key please let us know. This
is not a key we add. It may be there from some other MS project or app.

Does it have the value “MCD”?

Then delete only the value MCD. After this the key Platform was still there but empty, close
Regedit, make sure you exit and restart the SyncStudio Sync Management Conosle. The re-open
SyncStudio, re-open your project and try again to generate the code.

If the content of the dbSyncStudioSrvcBuildErrorLog.txt is different than above please email a
copy of it to support@handapps.com

Sync Server Deployment

To deploy the new synchronization server code to IIS please click on the “Sync Server
Deployment” tab on the left side of the SyncStudio.
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l 4 Sync Server Deployment

{E User Maintenance

Reports

:"rDepby Sync Service

This will deploy the generated Server-Side Synchronization Code to IIS. Before deployment you first need to configure

the database, Provision (if changes were made) and re-generate the code.

SyncStudio [SYNC_SAMPLE] - X
FEile  Help
3y
32 Home it Sync Server Deployment
#® Connection Settings
WebSite |Defau\l Web Site & |
/7] Database Ariicles Application Name ~ |[SYNC_SAMPLE |
& Database Provisioning Physical Path C:\Program Files (x86)\SyncStudio\Projects\SYNC_SAMPLE
\SyncSRW Browse
Code Generation -
& Application Pool SyncStudicAppPool ~ |

SyncStudio has an automated deployment feature to move the code and configure your Web
Service code to run under IIS. This utility is there for your convenience—you could always copy
the contents of the Build directory in your project to a virtual directory that you create in 1IS
yourself, and manually configure IIS.

DnAppSync Deployment Finished

o The SyncStudio Project SYNC_SAMPLE has been deployed to IS

0K

Notes:

1) SyncStudio needs to run in an Application Pool that is configured to use the .NET
Framework Version 4.x. We create on called “SyncStudioAppPool” and configure as

needed.

2) SyncStudio requires IIS 7 and up to run.
3) The project will be deployed to the Default Web Site (unless you change it).
4) The project will be deployed to a directory in wwwroot.
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m [ » DBAS64 » Application Pools

File View Help
[ C—
# | % PP & Add Application Pool..
4 qi DBAS‘M_ (D?AS_&\dbappsyr‘ This page lets you view and manage the list of application pools on the server. Application pools are ety [l o ol Pl
-{_ﬁ\.pplmﬂmn Pools| associated with worker processes, contain one or more applications, and provide isolation among @ Hep
b -[8] Sites different applications. .
Online Help
Filter: - mﬁo - % Show All | Group by: Mo Grouping <
Mame = Status .NET Fram... Managed Pipel.. Identity Applicati
@ASP.NFI’ w40 Started w0 Integrated ApplicationPoelld... 0
@A’SP.NH w40 Cl.. Started w40 Classic ApplicationPoelld... 0
@ Classic MET Ap... Started w20 Classic ApplicationPoolld... 0
@ DefaultAppPool  Started w20 Integrated ApplicationPoelld... 1
@S}rncStudinApp... Started w40 Integrated MetworkService 3
< n »
a “, v - | Features View |I"%) Content View

Ready
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Create at least one User

SyncStudio uses the SQL Server authentication mechanism; our users need to also be SQL Server
users. You can use our User Maintenance form to create and manage these SQL user id’s.

Every user (i.e., client device) in your system must have a unique SQL user id in order for it to
be able to synchronize.

SyncStudio [SYNC_SAMPLE] — b4
File  Help

s

s Home ﬁ Users Maintenance

*mm User swurd Ne Device [ID Version UplSl Last Sync
pre= v

£ Database Articles
[ Database Provisioning
& Code Generation

ESymSewerDepbyrmm

Is User Maintenance

P4 P =X B

You can configure any number of users in your user table, but the system will not operate if
there are more users than you are licensed for (Important. if your license allows you to have
only 10 users and you configure 11 users the sync will stop working for all the users, not just
the 11" one). Demo Licenses (what you get when you download the SyncStudio demo) allow
only 3 users—please do not configure more than 3 users for a demo license or you will receive
an error message during the synchronization test.

For this test we will be configuring one users, with User Id USERT.
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First, click on the tab called “User Maintenance” on the left then click on the button and fill
in the form.

Add/Edit User
User Name USERT1
Password |**~* |
Re-Type Password |**** |
Upload Batch Size 100 =
Active
Save Cancel

The Upload Batch Size determines how many records the remote client will send (new, modified)
in a single batch. 100 is the default but the value can be higher or lower depending on your
application and what device you are using. 10 is the minimum.

Your users cannot share User Ids. Every user in SyncStudio must have a different User Id,
otherwise they will interfere with each other and they will not be able to synchronize.

If two of your users accidentally use the same User Id (and Password) they will interfere with
each other and will not be able to synchronize. If this happens the only recourse is to have both
of them delete the local database (you will lose any pending transactions), enter the appropriate
User Id and Password for each one in their respective devices and re-synchronize, which will
require a full download.

Please note that this should never happen during normal usage because every user should not
only have a unique User Id, but also their secret password, which they should never give to
anyone else.

Additionally, sharing User Ids is a violation of the SyncStudio licensing terms, since we license
this product on a per-user basis. In other words, it is not allowed (or possible) to buy a 5 user
license and then have 100 users by giving everyone the same User Id and password—it will fail,
your users will lose any transactions that have been entered but not uploaded to the server and
will be forced to re-synchronize with a full download.
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The SyncStudio Android Client

You can use Standard SyncStudio Android Client .apk that is delivered with your installation
package, or load the client in the Basic4Android development environment and execute it.

Note: When Device has no Menu button

On some Android devices the “Menu” button/icon has been eliminated. However, most of these
devices have the option of turning on the assistant menu. The following video shows how to do
it on a Samsung device.

https://www.youtube.com/watch?v=fH5C2EgcrhQ

When you open the SyncStudio Android Client for the first time there will see a screen similar to
the following.

‘ > Profile: DEBUG EMULATOR Version 1.30.0004

SyncStudio

Copyright (c) 2014 MobileFast Corporation
www.dbsyncstudio.com

‘ Sync Now ’

DB Folder: dbsyncstudio DB Name:dbsyncstudio.db

Tap the Android Menu button and select the “Profiles” menu option. This will show a list of the
available sync server profiles.
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DEBUG EMULATOR

1 Sync Profile defined

Tap the Menu again and choose “New Profile” to create a new profile, which in this example we
called “SALES”:

Our profile will be called SALES and we will assume that the server is located in a development
machine in the local network. In this case the IP address of the development machine is
192.168.1.115 (you own IP will likely be different!).

The Server URL will be: http://192.168.1.115/SYNCSTUDIO_SAMPLE/
We will enter the following parameters:

USER ID = USER1

PASSWORD = test (or whatever you set it to when created)
USER GROUP = (leave blank)
DB Folder = TEST (local folder on SD card)

DATABASE NAME = TESTDB
No SSL.

Once you have filled-in the profile information click the Menu key on your device and select the
“Save Profile” option, as seen below:
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Profile Name

‘ SALES l
Server Address (enter the IP address or the name)
‘ 192.168.1.115 l
Sync Project Name (no spaces allowed)
‘ SYNCSTUDIO_SAMPLE l
Server Port (leave blank for ports 80 or 443) :
User 1D
{ USER1 }
Save Profile Delete Profile Cancel Edit Delete Local DB
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Notes:

Blanks and/or special characters are not allowed in the Server Address, Project Name, User Id
and User Group. Use a-z,A-Z,0-9 and the Underscore character (_) only.

You can specify a port number in the Server Port field. Normally, this will be either port 80
(http) or Port 443 (https or SSL). For ports 80 and 443 you can leave this field blank and use the
SSL checkbox in the profile, or else you can specify a custom port number.

After creating the new profile, it will be selected as the one to use. To switch profiles, tap on
the radio-button to the right of the profile name to make it the active profile:

DEBUG EMULATOR

SALES ®

2 Sync Profiles defined

At this point we are ready to synchronize (we assume that you have followed all the prior steps
so that your sync server has been deployed to a web server that is “visible” from the Android
device. Tap the back key on your device to return to the home screen.
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‘ . Profile: SALES Version 1.30.0004
>

&7
SyncStudio

Copyright (c) 2014 MobileFast Corporation
www.dbsyncstudio.com

‘ Sync Now

DB Folder: TEST DB Name:TESTDB

Tap on the “Sync Now” button and tap “Yes”. The device will now attempt to synchronize with
the server. If the database did not exist (as it would for a new profile) it will be created for you.

" Profile: SALES
.

Sync Finished

Schema Records: 238
Records Uploaded: 0
Records Downloaded: 237
Inserted: 237

Updated: 0

Deleted: 0

At the end of the process you will have a copy of the server database with all the records that
were selected for synchronization. In this example 238 records downloaded. If you go back to

the main screen (just press the “Back” button) and then tap the menu button and select “Logs”
you will see the following screen:
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L.-|

SyncStudio Client

‘ o, Profile: SALES Version 1.30.0004

2014-02-26 17:11:15, 237 Records Synced

Click the entry for the session to get the details:

Profile: SALES

Date: 2014-02-26 17:11:15

Session: 3ee0d133fcd1d039509dchb4b4f2327454a5596e0
Total Records: 237

Total Records Received: 237

Total Records Sent: 0

Table=COMMENTS, RECV Ins=5 Edits=0 Del=0
Tahle=CUSTLIST, RECV Ins=68 Edits=0 Del=0

Table=ITEMLIST, RECYV Ins=155 Edits=0 Del=0

Table=SLSCOMM, RECV Ins=9 Edits=0 Del=0
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